
  
 Introduction to Systems of Ordinary Differential Equations 
 

Systems of ODEs generates numerical solutions of systems of up to 6 first order ordinary
differential equations containing parameters. These solutions can be tabulated and plotted. A
user supplied function can also be plotted. 

The independent variable is "t", and the dependent variables are "u", "v", "w", "x", "y", and "z".
The allowable parameters are "a" though "r", excluding "e" (which has its usual numerical
meaning). 

  
 Creating and Loading Systems of ODEs 
 

When you first run the program the Main Window is opened, and you will see that essentially
the only commands available, are "New", "Open System", and "Open Environment" on the
toolbar, and "New System", "Open System", and "Open Environment" under the "File" menu. 

The Main Window

Selecting "Open System" or "Open Environment" allows you to load System files (ending with
"syw" and "env" respectively) that have been previously created. If you use "Open System" or
"Open Environment", then the current ODEs are overwritten by the loaded ODEs, and lost. 

To create a system, complete the appropriate boxes alongside "du/dt", "dv/dt", ... , "dz/dt",
along with the initial values, "u(t0)", "v(t0)", ... , z(t0)". The initial time is "t0" and the final
time is "t1". If "t1" is less than "t0" then solutions are generated backwards in time. 

The ODEs may contain 

 The independent variable "t". 
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 Any of the dependent variables "u", "v", "w", "x", "y", "z". 

 Any of the allowed parameters "a" though "r", excluding "e". 

 The constants "e" and "pi". 

 The standard mathematical functions and operations that the program recognizes. 

The initial values may contain 

 Any valid number. 

 The constants "e" and "pi". 

 Any of the above two combined lawfully with the operators +, -, *, /, and ^
(exponentiation). 

An optional function f(t) can also be defined. Usually this would be an exact solution of the
system of ODEs. The function may contain 

 The independent variable "t". 

 Any of the allowed parameters "a" though "r", excluding "e". 

 The constants "e" and "pi". 

 The standard mathematical functions and operations that the program recognizes. 

The functions that the program recognizes can be seen by clicking on "View Recognized
Functions and Operators" button, which displays the "Recognized Functions" window. A more
detailed summary can be found here. 
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A single-click opens a tooltip, with an explanation of the function. There are three different
ways to cut-and-paste a function to an ODE box. 

 Single-click on the function, right-click to open a drop-down menu, and select "Cut".

 Single-click on the function, and then click "Copy". 

 Double-click on the function. 

Then paste the function in the appropriate box. 

After the ODEs (and optional function) have been created, pressing the "Accept" button
checks the validity and consistency of these equations. The program automatically removes
all spaces and converts all characters to lower case. 

If any parameters are used in the ODEs then they are exposed under "Parameters". The
parameter values, like the initial values, may contain 

 Any valid number. 

 The constants "e" and "pi". 

 Any of the above two combined lawfully with the operators +, -, *, /, and ^
(exponentiation). 

The step-size "s", which defaults to 0.01, can be changed. This is the number used by all the
numerical and plotting techniques.

The following toolbar commands are now active: 

 "Save System", which saves the existing ODEs to a Systems file with extension "syw". 

 "Edit", which allows you to edit the existing ODEs. 

 "New", deletes the existing ODEs, and starts afresh. 

These commands are also available under the "File" menu item.
The following buttons are also active. 

 The "Numerical" button. Clicking this automatically opens the Numerics Window. 

 The "Plot 1 Window" button. Clicking this automatically opens the Plot 1 Window, which
plots numerical solutions in one graphics window.

These commands are also available under the "Operations" menu item. (The "Plot 2 Windows"
and "Plot 4 Windows", which plot numerical solutions in two and four graphics windows, are
under construction.)
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 To Install Systems of Ordinary Differential Equations 
 

To install Systems of ODEs, unzip systems.zip, and copy the files

systems.exe (the application, Systems)
systems.chm (the Compiled HTML Help file, systems)
spb.dll (an add-on library)
webpage.ini
All files with the extensions SYW or ENV

into the directory of your choice. No formal installation process is necessary. Systems of ODEs
does not make any changes to your operating system and uninstalls cleanly. 

Files with the extensions SYW or ENV contain previously created systems. Those that start
with "DL", such as "DLPage29.ENV", refer to the text "Differential Equations : Graphics Models
Data" by David Lomen and David Lovelock, Wiley 1999. Those that start with "JMC", such as
"JMCPage27.ENV", refer to the text "Differential Equations : An Applied Approach" by J.M.
Cushing, Pearson/Prentice Hall 2004. 

 
 To Run Systems of Ordinary Differential Equations 
 
To run Systems of ODEs, move to the directory containing the files and select the application 
Systems, that is, systems.exe. It should run on Windows 98, Me, 2000, and XP, which has
Windows updated so that the Microsoft .NET Framework 1.1 is installed. To check this
for Windows XP, go here. 

 
 To Uninstall Systems of Ordinary Differential Equations 
 
To uninstall Systems of ODEs, delete the files

systems.exe (the application, Systems)
systems.chm (the Compiled HTML Help file, systems)
spb.dll (the add-on library)
webpage.ini

You should also delete all files with the extensions SYW or ENV. 
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 Valid Functions
 

Here is a list of valid expressions followed by some important comments. 

Expression Meaning

+ plus

- minus

* multiply

/ divide

^ exponentiation

pi The number 

e The number e

( 0pen parentheses

) close parentheses

abs(t) absolute value of t, |t|

acos(t) arccos(t) of t, inverse
cosine of t

asin(t) arcsin(t) of t, inverse sine
of t

atan(t) arctan(t) of t, inverse
tangent of t

ceil(t) ceiling of t, the smallest
integer > t

cos(t) cosine of t, with t in radians

cosh(t) hyperbolic cosine of t

exp(t) exponential of t, e^t or et

floor(t) floor of t, largest integer < t

log(t) natural logarithm of t, ln(t)

log10(t) log of t to base 10

sin(t) sine of t, with t in radians

sinh(t) hyperbolic sine of t
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sqrt(t) square root of t

tan(t) tangent of t, with t in
radians

tanh(t) hyperbolic tangent of t

Comments

 t^2/3 = (t^2)/3 not t^(2/3). 

 If you want ta/b use (t^(1/b))^a rather than t^(a/b). 

 sin t will produce an error message. Use sin(t). 

 If you want loga(t) use log(t)/log(a). 

 If you want cos(t), sin(t), and tan(t), where t is in degrees and not radians, use
cos(pi*t/180), sin(pi*t/180), and tan(pi*t/180). 
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 Menus
 

There are four main menu items: 

 "File" 

 "Operations" 

 "Options" 

 "Help" 

 File 

Clicking "File", exposes the following submenu commands:

 "New System", which deletes the existing ODEs, and starts afresh. 

 "Open System", which loads from disk the ODEs from a previously saved Systems file (with
extension "syw"). The current ODEs are overwritten by the loaded ODEs, and lost. 

 "Open Environment", which loads from disk the ODEs and the graphical environment from a
previously saved Systems file (with extension "env") and opens the Plot 1 window using
the graphical environment. The current ODEs are overwritten by the loaded ODEs, and
lost. (The environment includes such things as the variables selected for the axes, the
maximum and minimum for these variables, and the selected tab.) 

 "Save System", which saves to disk the existing ODEs to a Systems file with extension
"syw". 

 "Edit System", which allows you to edit the existing ODEs. 

 "Exit", which closes Systems. 

 Operations 

Clicking "Operations", exposes the following submenu commands:
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 "Numerical Methods", which automatically opens the Numerics Window. 

 "Plot in 1 Window", which automatically opens the Plot 1 Window, which plots numerical
solutions in one graphics window.

 "Plot in 2 Windows", which is under construction 

 "Plot in 4 Windows", which is under construction. 

 Options 

Clicking "Options", exposes the following submenu commands.

 "Hide Tooltips". If unchecked the tooltips are visible, otherwise hidden. 

 "Help from Web". If unchecked when Help is used, Systems looks for the Help file
Systems.chm on your local disk. If checked when Help is used, Systems opens your
browser and looks for the Help files from the web. The Help files contain identical
information. 

 "Font size". Selecting this opens a window that allows you to change the font size and
boldness in the equation and expression text boxes. The effect is immediate. This option
is useful when projecting the screen in a classroom. 

 Help 

Clicking "Help", exposes the following submenu commands.

 "Help", which opens this Help file either from your local disk, or from the web, depending
on whether "Help from Web", under the "Operations" menu, is unchecked. The Help files
contain identical information. 

 "Webpage", which opens a browser at a user-selected webpage, in this case the Home
page of Math 355 at the University of Arizona,
"http://math.arizona.edu/~cushing/355.html". When Systems runs, it checks to see
whether the text file "webpage.ini" exists (in the same folder as "systems.exe"). If it does
not exist, this menu item is absent. If it does exist, the first line of this file is the URL
used when "Webpage" is clicked. The second line is optional, and if included is appended
(between brackets) to "Webpage" in the menu, which in out case leads to "Webpage
(Math 355 Homepage)". Thus, our "webpage.ini" file reads:

http://math.arizona.edu/~cushing/355.html
Math 355 Homepage
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For instructions on how to edit this file, see the FAQs. 

 "Credit", which opens the Credits page of the Help file either from your local disk, or from
the web, depending on whether "Help from Web", under the "Operations" menu, is
unchecked. The Credit files contain identical information. 

 "About", which contains copyright informations and the version number. 
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 The Numerics Window
 

Clicking on "Numerical" in the main window, opens up the Numerics Window.

The system of ODEs from the "Main Window" is copied and used here. After opening the
Numerics Window, any changes made on the Main Window are updated on the Numerics
Window. (This is different from what happens in the Plot 1 Window). 

The Numerics Window

Under "Methods" there are four different numerical routines to choose from: Euler's Method,
Heun's Method (sometimes called the Modified Euler's Method), Runge Kutta 4, or Adaptive
RK4 (adaptive stepsize Runge Kutta 4). (Adaptive RK4 is under construction.) 

Under "View" there are three different options to go with the numerical method, once the
"Apply" button is clicked. 

 "Table of values". 

 "Result of calculation". 

 "Comparison by step size". 

The option, "Frequency", alongside "Table of values", allows you to select the number of
calculations shown in the table. The options are 1, 2, 5, 10, and 100. Selecting "1" shows
every line in the table, "2" every second line, "5" every fifth line, and so on.

The option "Number of decimals" allows you to change the number of decimal places displayed
from the default of 6 to any number from 1 to 10. However, this is purely for cosmetic
purposes. All calculations are carried out to 15 decimal places. 

The option "Font size" allows you to change the font size used in "Table of values", "Result of
calculation", and "Comparison by step size" from the default of 9 points, to 10, 12, 12,114, 16,
18, or 20. The effect is immediate. Checking "Bold" makes the font bold, after the font size is
changed. This option is useful when projecting the screen in a classroom.
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The following buttons are active. 

 "Apply", which solves the system of differential equations numerically based on the
selections made in "Methods" and "View", using the current step size. 

 "Cancel", which closes the Numerics Window, and any of the windows generated from it. 

 "Help", which shows this help file. 

 "Main", brings the Main Window into focus. 

 "Show ODEs", which shows the current ODEs, initial values, parameters in use, etc. 

 "Close Tables", which closes any open tables. 

 Table of values 
This uses the selected numerical method and step size to create and display a table of values
such as

(This is for the ODE 
du/dt = u, u(t0) = 1, t0 = 0, t1 = 1,

with s = 0.1 and f(t) = et using Runge Kutta 4).

The maximum number of points calculated is 5000.

If a function f(t) is defined, as it is here with f(t) = et, then its values are also displayed. If
the system consists of one ODE, as it is here, then the "Error" (the difference between the
value of f(t) and the numerical approximation to the solution), and "% Error" are also shown.

The following buttons are active. 

 "Save", which saves the system of ODEs and current table to a text file, with extension
TXT. 

 "Export", which saves the table as a column delimited text file with extension DTA. This is
the same as "Save" except no details of the ODEs are included. This is useful for importing
into other software. 

 "Print" which prints the current table and the system of ODEs to the local printer. 

Page 11



 "t1 to t0", which continues the table from where it left off. 

 "Cancel", which closes the table. 

 Result of calculation 
This generates a one line output similar to "Table of values", but shows only the final result.
Unlike the "Table of values", it is not limited to 5000 calculations. Depending on the "t1" and
the step size, the time to finish can be long, so a progress bar and an "Abort" button are
exposed, allowing you to abandon the calculations.

 Comparison by step size 
This generates an output similar to "Result of calculation" but it reduces the step size by half
until the "Number of step size halvings" has been reached. You can choose the number of
halvings to be 4, 8, 12, and 16. Because the time to finish grows exponentially as the number
of halvings increases, a progress bar and an "Abort" button are exposed, allowing you to
abandon the calculations.

Also displayed is the final time at which the calculation occurred, "t1". If (t1 - t0)/s is not an
integer then the calculation will stop earlier than the original t1. That did not happen in this
case.

If f(t) is defined then "Ratio" represents the ratio of the previous error to the current error. In
this example, these ratios are about 16, which suggests that, with Runge Kutta 4, halving the
step size increases the accuracy 16 times.

"Comparison by step size" is not available using Adaptive RK4. 
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 The Plot 1 Window
 

Clicking on "Plot 1 Window" in the main window, opens up the Plot 1 Window, where numerical
solutions can be plotted in a Plotting Window.

The system of ODEs from the "Main Window" is copied and used here. After opening the Plot 1
Window, any changes made on the Main Window are not updated on the Plot 1 Window. (This
is different from what happens in the Numerics Window). 

The Plot 1 Window

Above the Plotting Window you can select the variables that you want to use on the vertical
and horizontal axes. The ODE that is being used here is 

du/dt = u, u(t0) = 1, t0 = 0, t1 = 1,
with s = 0.01 and f(t) = et, so "u" and "t" are selected automatically.

To the left of the selected variables "u" and "t" is "Time" followed by an arrow, in this case
pointing to the right. This means that plotting will be "forwards" in time. If the arrow points to
the left, then plotting will be "backwards" in time. 

To the left of the Plotting Window are various tabs. The one that is exposed is the "Window"
tab, which is where the minimum and maximum of each variable's window can be set. The
default is -10 to 10 for each variable except "t", which defaults to "t0" and "t1". Note that the
minimum and maximum of "t" need not coincide with "t0" and "t1".
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The other tabs are 

 "Commands" 

 "Parameters" 

 "System" 

 "Auton" 

There are 6 buttons at the bottom left of the Plot 1 Window.

 "Cancel", which closes the Plot 1 Window. 

 "Print", which allows you to print the Plot 1 Window to a printer (as long as the window
has not been resized), or to a file. Various graphics file types are available: BMP, GIF,
JPEG, PNG, TIFF, and WMF. 

 "Help", which shows this help file. 

 "Save Environment", which saves the existing ODEs (and the graphical environment) to
disk with extension "env". (The environment includes such things as the variables selected
for the axes, the maximum and minimum for these variables, and the selected tab.) These
are the files that can be loaded later using "Open Environment" under the "Main Window". 

 "Show ODEs", which shows the current ODEs, initial values, parameters in use, etc. 

 "Restore", which restores the window to its original size so that printing can be enabled. 

There are 4 buttons at the bottom right of the Plot 1 Window. These buttons are duplicated in
the "Commands" tab.

 "Plot", which plots the numerical solution to the ODE in the chosen Plotting Window, based
on the selection made in "Methods" under the "Commands" Tab. The color of the plot
depends on the method selected: Euler in red, Heun in green, and RK4 in blue. 

 "Continue Plot", which becomes available after a plot. It continues plotting the numerical
solution using the final values of the variables from the previous plot become the new
initial variables of the current plot. It is equivalent to "t1 to t0" on the Numerics Window. 

 "Forwards", which means that plotting will be "forwards" in time, as is indicated by arrow
alongside "Time" at the top of the Plotting Window. Clicking the "Forwards" button
changes the direction of the arrow and the word "Forwards" is then replaced by
"Backwards". If the horizontal variable is "t" and the maximum and minimum of t coincide
with t0 and t1, the Plotting Window is cleared and reset to the new values. Otherwise the
Plotting Window is unchanged. Pressing Plot then draws the ODEs in the new direction. 

 "Refresh", which clears the current Plotting Window. 
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Calculations cease if the point is well outside the Plotting Window.

When the window is resized, the Plotting Window is cleared.

 Commands 
Selecting this tab shows many of the commands available for plotting ODEs.

Under "Methods" there are four different numerical routines to choose from: Euler's Method,
Heun's Method (sometimes called the Modified Euler's Method), Runge Kutta 4, or Adaptive
RK4 (adaptive stepsize Runge Kutta 4). (Adaptive RK4 is under construction.) 

The buttons available are: 

 "Plot", which plots the numerical solution to the ODE in the chosen Plotting Window, based
on the selection made in "Methods". The color of the plot depends on the method
selected: Euler in red, Heun in green, and RK4 in blue. This button duplicates the "Plot"
button beneath the Plotting Window. 

 "Plot Initial", which places a dot at the initial point, if it is on the screen. 

 "Continue Plot", which becomes available after a plot. It continues plotting the numerical
solution using the final values of the variables from the previous plot become the new
initial variables of the current plot. It is equivalent to "t1 to t0" on the Numerics Window.
This button duplicates the "Continue Plot" button beneath the Plotting Window. 

 "Forwards", which means that plotting will be "forwards" in time, as is indicated by arrow
alongside "Time" at the top of the Plotting Window. Clicking the "Forwards" button
changes the direction of the arrow and the word "Forwards" is then replaced by
"Backwards". If the horizontal variable is "t" and the maximum and minimum of t coincide
with t0 and t1, the Plotting Window is cleared and reset to the new values. Otherwise the
Plotting Window is unchanged. Pressing Plot then draws the ODEs in the new direction.
This button duplicates the "Forwards" button beneath the Plotting Window. 

 "Plot f(t)", which uses the current stepsize to plot f(t) in turquoise on the Plotting
Window, if a function is defined and if the horizontal variable is "t". 

 "Reinitialize", which restores all the values and window sizes to the initial values. 
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 "Refresh", which clears the current Plotting Window. This button duplicates the "Refresh"
button beneath the Plotting Window. 

It is possible to Zoom "In" or Zoom "Out", either "Horizontally", "Vertically", or in "Both
Directions". Zooming can be undone, which also refreshes (clears) the Plotting Window.

Checking the "Show Coordinates" box, shows the coordinates as a tooltip under the mouse
pointer when the mouse is over the Plotting Window. The number of decimal points displayed
can be set from 1 to 10. 

The coordinates under the mouse pointer when the mouse is over the Plotting Window are
always displayed in the upper right. The "large Font" box, if checked, shows these coordinates
in a larger bold font. The effect is immediate. This option is useful when projecting the screen
in a classroom. 

Clicking in the Plotting Window when the coordinates are displayed as a tooltip causes that
point to become the new center of the Plotting Window, called Translating. Translating can be
undone using "Undo", which also refreshes (clears) the Plotting Window. 

To zoom in or out about a point, click on the point to make it the center of the screen, and
then click "In" or "Out".

 Parameters 
Selecting this tab shows the initial values of the dependent variables, the parameter values,
the initial and final times, and the step size.

Any of these can be changed, after which the "Accept" button should be clicked.

Clicking on "Transfer", copies the values of "t0" and "t1" to "t min" and "t max" under the "
Window" Tab. 

 System 
Selecting this tab shows the current system of ODEs.
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These values cannot be edited. To edit any of these values, close the "Plot 1 Window" and
use "Edit" on the "Main Window". 

 Auton 
If the system of ODEs is either autonomous (the right-hand side is independent of "t") or if
there is only one ODE, then this tab is exposed. Selecting this tab shows more commands
grouped under Slope Field and Family of Solutions.

Slope Field. If there is only one ODE, or, in the case of an autonomous system, if "t" is not
one of the variables selected in the Plotting Window, then the program will plot Slope Fields.
The number of horizontal and vertical slopes range from 5 to 40. The slopes can be of the
same or variable length.

If "Vector" is checked, the slope field becomes a vector field (also called a direction field). In
this case, the slopes have circular heads to indicate the direction of the vector, rather like a
tadpole. Here is an example
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corresponding to 
du/dt = u, u(t0) = 1, t0 = 0, t1 = 1.

Family of Solutions. It is possible to plot a family of solutions (that is, multiple solutions)
based on the current initial values and variables selected for the horizontal and vertical axes.
One of the two variables is kept fixed, while the other's maximum and minimum are divided into
an equal number of new initial points. The plot uses the Method selected under the Commands
Tab.

If the "Show init" box is checked, the initial points are shown.

If the "Plot Forwards and Backwards" box is checked, the solutions are plotted both forwards
and backwards in time.

While plotting a family of solutions a progress bar and an "Abort" button are exposed, allowing
you to stop the calculations at any time.

The original initial values are restored after the plots. Here is an example where the same t0 is
selected, and the default number of u0 solutions ("# u0"), 20, is used, and "Family of
Solutions, same t0" is clicked.
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 Context Menu 
When the mouse is over the Plotting Window, right-clicking reveals the Context menu, which
puts many of the commands available under the tabs, in one place.

The Commands to the right, are the same ones that appear under the Commands Tab. 

The first group on the left-hand side are the same ones that appear under the Auton Tab.

The second group on the left-hand side depend on the position of the mouse pointer when
you right-clicked to get the Context Menu. 

 "New Initial Point" makes the coordinates under the pointer the new initial point, and plots
this point. This menu item is visible if there is only one ODE, or, in the case of an
autonomous system, if "t" is not one of the variables selected in the Plotting Window. 

 "Select and Plot" makes the coordinates under the pointer the new initial point and then
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plots both this point and the numerical solution, based on the "Method" selected under
the Commands Tab. After plotting to a window in which "t" is not one of the plot
variables, the initial times are restored. This menu item is visible if there is only one ODE,
or, in the case of an autonomous system, if "t" is not one of the variables selected in the
Plotting Window. 

 "Select and Plot Both Ways" makes the coordinates under the pointer the new initial point
and then plots both this point and the numerical solution forwards and backwards, based
on the "Method" selected under the Commands Tab. After plotting to a window in which
"t" is not one of the plot variables, the initial times are restored. This menu item is visible
if there is only one ODE, or, in the case of an autonomous system, if "t" is not one of the
variables selected in the Plotting Window. 

 "Make Center of Screen" makes the point under the cursor the new center of the Plotting
Window. It is the same as clicking on the Plotting Window if "Show Coordinates" is
checked under the Commands Tab. However, here the "Show Coordinates" need not be
checked for this to work. "Undo" under the Commands Tab undoes this operation, and
clears the screen. 

 "Slope" draws a single slope at the pointer. This menu item is visible if there is only one
ODE, or, in the case of an autonomous system, if "t" is not one of the variables selected
in the Plotting Window. 

The menu items in third group are the same as those displayed at the bottom left of the Plot 1
Window.

The final group allows you to rapidly move to one of the tabs. 
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 Credits
 

Systems of Ordinary Differential Equations © Copyright 1993-2005.  All rights
reserved.
Jim Cushing, David Lomen, and David Lovelock
Department of Mathematics
University of Arizona
Tucson, Arizona 85721 

This software is dedicated to the memory of two of nature's gentlemen : 
John Bownds

and
Stavros Busenberg.

They did not meet on earth, but they have in heaven. 

We would like to thank the following for their valuable contributions: 

Larry Brakmo
Mike Kelly
Romeo Thomas.

We particularly thank Martin S. Schaeffer for the use of his equation parser. Martin is one of a
kind: talented, devoted, intelligent, modest, responsible, and incredibly capable. Thank you,
Marty.

We also acknowledge the support of the National Science Foundation. 

This program may be freely distributed by any means, including the web, provided that there
is no fee or charge or consideration of any kind which is in excess of $8.  However, we retain
all the rights of the program. 
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 History
 

Systems of Ordinary Differential Equations © Copyright 1993-2005.  All rights
reserved.
Jim Cushing, David Lomen, and David Lovelock
Department of Mathematics
University of Arizona
Tucson, Arizona 85721 

 August 25, 2005. Beta Version 0.30 released. 

 August 29, 2005. Beta Version 0.31 released. 

 Added, under the "Options" menu, the ability to read the Help files from the web. 

 Added, in the "Plot 1 Window" under the "Windows" Tab, the button "Transfer" which
copies the values of "t min" and "t max" to "t0" and "t1" under the "Parameters" Tab. 

 Fixed, in the "Plot 1 Window" under the "Auton" Tab, a bug when using the first
"Family Solution ..." button. 

 Fixed, in "Numerics" under "Result of calculation", a roundoff error problem. 

 Increased, in "Numerics", the maximum number of calculations allowed under "Table of
values" and "Result of calculation" from 1200 to 2000. 

 Made substantial changes to the Help files. 

 Created a PDF version of the Help files that can be downloaded separately from the
web. 

 September 3, 2005. Beta Version 0.32 released. 

 Added, in "Numerics" alongside "Table of values", the combobox "Frequency", which
gives the option of showing every line of the table, every second line of the table,
etc. 

 Rewrote, in "Numerics", the "Result of calculation" algorithm so it is not limited to 2000
calculations. 

 Increased, in "Numerics", the maximum number of calculations allowed under "Table of
values" from 2000 to 5000. 

 Added, in the "Main Window" under the menu item "Options", a menu item "Font Size".
This changes the font size and boldness in the equation and expression text boxes. 

 Added, in "Numerics", the ability to change the font size and boldness in the "Result of
calculation", "Comparison by stepsize", and "Table of values". 

 Added, in "Plot 1", the coordinates of the point under the cursor. 

 Added, in "Plot 1" under "Commands" tab, the ability to change the font in the
previous change. 

 Added, under the "Help" menu, the menu item "Webpage". This opens the webpage

Page 22

http://www.math.arizona.edu/~dsl/dl.htm


designated in the "webpage.ini" file. The first line of this file should be a valid URL. The
second line is optional, and the text is appended (between brackets) to "Webpage" in
the menu. 

 Added "FAQs" to the Help. 
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 FAQs
 

 When I try to read the Help files from within Systems, I get the Windows' error
message: "Action Canceled - Internet Explorer was unable to link to the web page
you requested." What is happening?

This occurs if you are running Systems from a network. This was recently introduced as a
security feature by Microsoft. See 
http://www.grainge.org/index.htm#authoring/ms05-026/ms05-026_update.htm for
instructions if you want to try to override this. However, it is much safer if you either 

1. Run Systems from a local computer. 

2. Use the menu option in Systems to read the Help files from the web. 

3. Download the Systems Help files in PDF format. 
 

 Under the "Help" menu there is a "Webpage" option. How do I direct it to the
webpage of my choice?

This requires editing, or creating, the text file "webpage.ini", which should be in the same
folder as "systems.exe". Use a text editor, like "Notepad". Do NOT use a word processor
program, such as "MS Word". (To open Notepad, click the Start button, click Programs,
click Accessories, and click Notepad.) 

1. The first line of this file should be the URL of the Webpage of your choice. To make
sure this is a valid URL, cut and paste the address from your browser. 

2. The second line is optional, and contains the text that will be appended to menu word
"Webpage". The line should not contain more than 20 characters. 

 

 I tried changing the "webpage.ini" file as directed, but I get an information
message at runtime, to the effect that "The first line of Webpage.ini does not seem
to be a URL." What do I do?

There are three possible causes for this. 

1. The file "webpage.ini" was created or edited using a word processor rather than a text
editor. 

2. The first line of this file does not contain a valid URL. Cut the URL from your browser
and paste it to the first line in "webpage.ini". 

3. The first line of this file does contain a valid URL, but Systems thinks it is invalid. This
might occur if the URL contains strange characters. As a temporary measure, create
a TinyURL for the webpage, and use that as the first line in "webpage.ini". Then email
me explaining the problem and including the offending URL, so I can modify the URL
validation routine. 
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